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Introduction

Active Management Technology (AMT) allows for out of band management (OOB) of systems regardless
of their current power state. The initial version of AMT shipped with the HP Compaq dc7700 Business PC
with vPro technology systems is referred to as AMT version 2.0. Version 2.0 will keep the management
engine (ME) active executing the AMT firmware during sleep and power off states when OOB manage-
ment is configured. With this configuration, the HP Compaq dc7700 Business PC with vPro technology
will draw power during these states to provide the OOB capabilities. In some business configurations,
power draw is a big concern. AMT 2.1 addresses this concern by allowing the ME to be placed into a
lower power state to greatly reduce the power draw during system sleep and power states when OOB
management actions are not taking place.

The procedure for updating system firmware is different than on past products. The ME firmware is a sep-
arate entity which can be updated independent of the system BIOS firmware. In the ME sections, the term
“provisioned” describes a vPro AMT system that has been configured by the customer (user or administra-
tor). Please consult the HP white paper “vPro Setup and Configuration for the dc7700 Business PC with
Intel vPro Technology” (http://h20000.www2.hp.com/bizsupport/TechSupport/Documentin-
dex.jsp?contentType=SupportManual&lang=en&cc=us&docindexld=179911&taskld=101&prod-
Typeld=12454&prodSeriesld=3232028#7) for information regarding the vPro provisioning process.

This white paper outlines Hewlett-Packard business PC BIOS flashing and ME update options for the
2006 vPro products. Users or administrators can choose the best method depending on the operating
environment of the computer(s). BIOS and ME updates are available in a downloadable softpaq contain-
ing the BIOS image and upgrade instructions for the various methods. Regardless of the BIOS flash
method, business PC products provide a high degree of upgrade reliability and offer failure safe recov-
ery.

The remaining sections of this document answer frequently-asked questions concerning typical BIOS and
ME flash scenarios.

AMT 2.1 Specitic Changes

What is changing in the system upgrade process for AMT 2.12

To properly configure the HP Compagq dc7700 Business PC with vPro technology for the AMT 2.1 func-
tionality, the system must be altered in the following order:

1. Update the ME firmware to 2.1.0.1029 or later.
2. Update the system BIOS firmware to version 2.0x or later.
3. Configure the ME firmware “Idle Timeout” to allow lower ME power states during OOB inactivity.

ME firmware “Idle Timeout” determines the minutes the ME will wait for management activity during OOB
situations (system in a sleep state) before the ME will transition to a lower power state. This feature allows
the ME to draw less power during inactive OOB situations. If a remote console requests management

information, the ME wakes the system, reconfigures the ME, and places the system back into the original
sleep state. After this operation, the ME will respond to any management query and begin the wait cycle
again before going back to a lower power state. The section “How do | configure the ME Idle Timeout?”

on page 6 provides a detailed description of how the feature is configured.
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What files and directories are in a BIOS dc7700 softpag?

BIOS and ME updates are delivered to customers through downloadable softpags. Softpags are self-exe-
cutable programs which contain the BIOS image files and utilities to allow the BIOS to be updated in var-
ious manners. In cases like AMT 2.1 where ME and BIOS upgrades must be synchronized, the softpag
will contain the files necessary for updating both entities. Regardless of the upgrade manner chosen by
the user or administrator, HP business PC BIOS provides flash recovery in the event of a BIOS flash failure.
The softpaq is executed by selecting the file SPXXXXX.exe where XXXXX is a unique identification number
assigned to each softpaq. The softpaq will present the user with information about the softpaq contents,
how to use the softpaq, and a brief explanation as to the PC enhancements offered.

& Hp Compag Business Desktop System BIOS (786A5 BIOS) - InstallShield. .. EJ

TITLE: HP Compaq Business Desktop Swstem BIOS P
(786A5 BIOS) =

VERSION: D2.05 Rev. &

DESCRIPTICN:

This package contains wtilities that can be used to
restare or update the syskem BIOS on the listed desktop
models with a 786A5 BIOS,

Several methods For changing the BIOS version may be
chosen, Included in this package are the Following
rmethods:

- Create a ROMpaqg bootable BIOS upgrade/restare
diskette,

- Ise HPQFlash to upgrade the BIOS directly ina
Microsoft Windows environment,

- Create a ROMpaq bootable BIOS upgrade/restore CD,

This package can be used with S5M, HPCMS, or PXE
management software For remote updating of the BIOS.

MWOTE: To dete:rmine the BIOS Famil}-’ and BIOS date, hd

| Mext = | Cancel |

After acknowledging the license agreement, the softpaq allows the user or administrator to extract the
contents to any directory. The following files and directories are an example of those extracted from a typ-
ical BIOS and ME softpag; however, individual softpags may differ. Please see the softpaq documentation
files for exact contents.

®  786xx.cab - Compressed BIOS image that System Software Manager (SSM) can use to remotely
update a system.

®  SPxxxxx.cva - Identification file used in SSM remote BIOS upgrade.
®  BIOS Flash.htm - Web document describing the softpaq contents, ME, and BIOS upgrade methods.
*  How to Use.txt - Text document describing the softpaq contents, ME, and BIOS upgrade methods.
*  DOS Flash (directory):

e XXX_MMmm.bin - Binary BIOS image file required by Flashbin.exe.

*  Assignpw.exe - DOS utility to assign administrative/setup password to flsh.cpu.
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*  Flashbin.exe - DOS utility to update and/or restore BIOS.

*  Flsh.cpu - Hardware specific driver required by Flashbin.exe to update/restore the BIOS.
* BIOS CD (directory):

* BIOS.iso - CD image containing the binary BIOS file for F10 and flash recovery.

* Readme.ixt - Text document describing the iso file image.
* HPQFlash (directory):

*  HPQFlash.exe - Windows application to update and/or restore BIOS.

*  HPQFlash.txt - Text document describing HPQFlash.exe use and syntax.

*  HPQPswd.exe - Windows application that allows the user (typically a system administrator) to
create an encrypted password file that can be used with the /p option of the HPQFlash
application.

*  HPQPswd.txt - Text document describing HPQFlash use and syntax.
* ROM.CAB - Compressed BIOS image file used by HPQFlash.
®  ME Flash (directory):
*  XXX_bbbb.bin - Binary ME firmware update image.
* Local-DOS (directory).
- FWUpdLcl.exe - Local DOS ME firmware update tool.
* LocalWin (directory).
- FWUpdLcl.exe - Local Windows ME firmware update tool.

In what operating systems can | update the PC BIOS and Management
Engine Firmware?
You can update or restore the BIOS in Windows XP and Vista using the HPQFlash application. DOS envi-

ronments can use the Flashbin.exe utility. In situations with other Windows versions (NT, 95, ME), Linux,
or other operating systems, you can update the BIOS using F10 setup “Flash System ROM” feature.

You can update or restore the ME firmware locally in Windows XP using the FWUpdLcl.exe (Windows
version). DOS environments can use the DOS version of the FWUpdlLcl.exe tool.

You can execute remote ME firmware updates through the Intel AMT WebGUI when configured in SMB
mode. You can remotely update enterprise configurations through ISV console applications. Consult the
“vPro Setup and Configuration for the dc7700 Business PC with Intel vPro Technology” white paper for
AMT setup and configuration defails.

Q]
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Updating ME Firmware

How do | update the ME firmware in DOS locally?2

The DOS tool, FWUpdLcl.exe, is used locally by entering the tool name followed by ME firmware name.
In the following example, the command is entered fwupdlcl.exe 210_1028.bin. The fool begins
the updating process and displays “Performing Update ...". Once the process is complete, the tool dis-
plays “Update finished successfully”.

C:“\MEUPDATESLOCAL=-"13fwupd lcl.exe 218 _1828.bin
Firmware Update Utility version 2.1.0. 16828
Copyright (C) Intel Corporation, 2886

Checking firmware parameters...
Performing Update, . .

Irying to receive update status...
Update finished successfully

C :\MEUPDATENLOCAL-"1>_

The DOS tool update will work regardless of whether the ME firmware has been provisioned. If the HP
Compagq dc7700 Business PC with vPro technology has not been provisioned, this method is best for
update ease.

How do | update the ME firmware in Windows locally?

The Windows tool (FWUpdLcl.exe) is used locally in a Command Window with the format fwup-
dlcl.exe <mefirmware.bin> -generic. The AMT configuration does not have to be provisioned
for this tool to function. In the following example, the command is entered fwupdlcl.exe
210_1028.bin -generic. The tool begins the updating process and displays “Performing Update
...". Once the process is complete, the tool displays “Update finished successfully”.

Q]
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B8 Command Prompt ﬂgﬂ

K:“MEUpdatexLocal-Win>FlllpdLcl.exe 218_1828 _bin —generic
hecking firmware parameters...

Performing Update...

rying to receive update status.._.

pdate finizhed successfully

K:“MEUpdate-Local-Win>_

How do | configure the ME Idle Timeout?

Once you have updated the ME firmware and system BIOS, you can configure the ME firmware Idle Tim-
eout on provisioned systems to allow the ME to transition to lower power states during OOB sleep state
management. The Idle Timeout feature is operational only when the setting Intel ME ON in Host
sleep states is set to ON in the MEBx ME configuration menu. The default setting for this option is OFF.

The initial step to configuring the Idle Timeout is to enter the Management Engine BIOS Extension (MEBx)
setup menu by pressing CTRL+P during BIOS POST. If an administrator password has been established
in BIOS F10 setup, you must enter the administrator password to access the MEBx setup menu. If the HP
Compagq dc7700 Business PC with vPro technology has not been provisioned, you must change the ME
Password from the initial “admin” value to a strong password. The MEBx Password must be a strong pass-
word with the following requirements:

®  Must be between 8 and 32 characters.
®  Must contain both upper and lower case Latin characters (e.g. A, q, B, b).
®  Must contain at least one digit character (e.g. 0, 1, 2, ... 9).

®  Must have at least one non-alphanumeric character from the following valid list:
*  Valid characters:!! @ # $ % ~ * _

* Invalid characters: “*, > < : & (space )

Q]
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Intel(R) Management Engine BIOS Extension v2.1.4.8088
Copyright(C) 2863-86 Intel Corporation. All Rights Reserved.
[ MAIN MENU 1]

Intel(R) ME Configuration
Intel(R) AMT Configuration
Change Intel(R) ME Password
Exit

Intel(R) ME Password

[ESCI=Exit [ENTER]=Submit

After you enfer or establish the strong password, you can select Intel AMT Configuration > Idle
Timeout. ME firmware images that have been field upgraded to AMT 2.1 initially have this value set to
“0x0”, which disables the ME from entering a lower power state during OOB system management. To
enable this function, enter a non-zero value in either HEX or DECIMAL. In the following example, the Idle
Timeout value is set to “Ox1”, which configures the ME to transition to a lower power state if AMT is
configured to provide OOB during system sleep states affer 1 minute of idle time. All Idle Timeout val-
ues are in minutes. The lowest value of 1 minute offers the most energy savings.

Intel(R) Mamagement Emgine BIOS Extension vZ.1.4.0080
Copyright(C) 2063-86 Intel Corporation. All Rights Reserved.
{ INTEL(R) AMT CONFIGURATION 3

Host Hame

TCP/IP

Un=Provision

ULAN

SOL/IDE-R

Remote Firmware Update
PRTC

Timeout Value (BxB-BxFFFF)

Bxl

[ESCI=Exit CENTERI=Submit
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After you enter a valid timeout value, exit the MEBx to allow the new configuration to take affect. The tim-
eout value applies only to AMT monitoring of systems during sleep states such as Suspend to RAM (S3/
Stand by), Suspend to Disk (S4/Hibernation), or Soft Off (S5). This value will not affect the power draw

for AMT functionality while the system is active.

Will | lose my AMT setup configurations when updating ME firmware?

Any AMT configurations created with the AMT 2.0 image are maintained after the update process to
AMT 2.1. ME firmware updates do not modify any data previously stored by the ME. Any new configura-
tion options that are available only in AMT 2.1 and beyond are initialized to a default value.

Updating PC BIOS

Will | lose my setup configurations when updating the BIOS?

F10 setup configuration options, passwords, and settings are not lost during BIOS update or restore.

How do | update my PC BIOS in Windows XP or Vista?

In single PC situations, the user or administrator should use the HPQFlash executable. For a system admin-
istrator with a network of Windows business PCs to update, HPQFlash can be deployed through the use
of System Software Manager (SSM) to update all the appropriate PCs.

How do | update the BIOS in a DOS environment?2

You can execute the Flash Bin Firmware Upgrade Utility (Flashbin.exe) in a DOS environment to upgrade
or restore a PC BIOS image. The utility uses a driver (flsh.cpu) for specific hardware flash operations. The
BIOS binary image should be included in the same directory as the utility and driver with the name for-
mat XXX_MMmm.bin. The user can execute the utility by simply typing £1ashbin. The current PC BIOS
will be examined for compatibility with the binary image. If the BIOS image file is an older BIOS version
that the current PC BIOS, the user will be warned. After the user confirms that the BIOS upgrade/restore
should proceed, the utility will begin the flashing process. The user will be warned not to reboot or power
cycle the PC during the flash process. However, if the process is interrupted or does not complete success-
fully, the business PC flash recovery process will automatically activate upon reboot. After the BIOS
upgrade process has successfully completed, the user must reboot or power cycle the PC for the new BIOS
image fo take affect.

The Flashbin utility must be executed in a DOS environment. If the user does not have DOS bootable
media available, a USB flash media (Disk On Key - DOK) or CD can be created to deliver the Flashbin
utility, driver, and BIOS image.

If the administrator/setup password has been established on the business PC, the Flashbin utility driver
must be assigned the password. Assign Password (Assignpw.exe) can be used with DOS Flash if an
administrative/setup password has been previously set on the target PC. To assign a password to DOS
Flash, change directories to the directory that contains Flashbin.exe and type assignpw flsh.cpu.
You will be prompted to type in the password. Press Enter after you have typed in the password. You
may use the Backspace key to correct mistakes. You will then be prompted to confirm the password that
you just entered. Pressing Enter before any password keys have been typed in will unassign the previ-
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ously assigned password. You may need to do this if the administrative/setup password is deleted from
the client machines. To assign a new password, run the Assign Password utility again.

How do | update the BIOS when not running Windows XP, Vista, or DOS?

You can update BIOS using the F10 setup “Flash System ROM” feature. Reboot the PC and press F10 to
enter setup. In the File menu, select Flash System ROM.

Hewlett-Packard Setup Utilit
Storage Security Pouwer Advanced

System Information
About

Set Time and Date
Flash Suystem ROR

Replicated Setup

Default Setup

fipply Defaults and Exit
Ignore Changes and Exit
Save Changes and Exit

T a—— ety O e vt [ ) 1TV

This flash utility will present the user with the option to select the media containing the BIOS image file
(7E1_MMmm.bin). F10 ROM based flash can accept the binary file from the root directory of any remov-
able media such as USB and CD. Use the BIOS.iso file included in the softpaq to create a BIOS image
CD. When flashing with F10 ROM based flash, the CD media must be El-Torito compatible.

Q]
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Heulett-Packard Setup
Storage Security Pouwer Advanced

System Information
About

Set Time and Date Flash System ROM
Flash System ROR
Select a drive:

Default Setup USB

Replicated Setup

Apply Defaults and F18=Accept, ESC=Cancel
Ignore Changes and Exit
Save Changes and Exit

AL: <Fl=Help> REMOTE: F1=ESC+1, F5=ESC+5, F18=ESC+0

When the media is selected, the user is presented with a list of valid binaries. If the BIOS cannot read the
media or media files, an error message is displayed and another media source can be selected.

Storage Security Pouer Advanced

System Information
About

Set Time and Date
Flash Suystem ROA

Error

Replicated Setup

Removable Media is bad or missing,
Default Setup

Press any key to continue

Ignore Changes a
Save Changes and Exit

e

Once the desired binary image is selected and confirmed, the BIOS begins the flashing process. Do not
interrupt the flash process. The percentage completion displays during the process.

Q]
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Heulett-Packard Setup Utilit
Storage Security Pouwer Advanced

System Information
fibout

Set Time and Date Flash System ROH ——

Flashing System ROM
Replicated Setup Do HOT remove Pouer.

Default Setup TB6E1 v1.085 -> v2.01

fpply Defaults and Ex 11T |
Ignore Changes and Ex

Save Changes and Exit 50

AL: <Fl=Help> REMOTE: F1=ESC+1, F5=ESC+5, F18=ESC+0

The user is prompted when the process is completed. The new BIOS code will not take effect until the PC
is rebooted.

Heulett-Packard Setup Utility
Storage Security Power Advanced

System Information
fibout

Set Time and Date
Flash Sustem ROH

Success

Replicated Setup

System BOH Flash was successful,
Default Setup

Press any key to continue
fipply Defaults an
Ignore Changes an
Save Changes and Exit

<Fl=Help>

Alternatively, the user or administrator can use a Preboot eXecution Environment (PXE) to boot to a PXE
server, such as Altiris. The Flashbin utility can be executed in the PXE DOS-like environment to perform the

BIOS upgrade.
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What steps are necessary to execute the HPQFlash utility?

The HPQFlash application is executed in the Windows environment by selecting the HPQFlash.exe file.

The initial HPQFlash application window is presented as follows, reminding the user that additional appli-
cations should be closed before proceeding.

HPO Flash Wizard

YWelcome to the HPQ Flash Wizard

This wizard will guide you through the process of updating the
system BIOS on your machine.

It iz strongly recommended that all applications are
4 clozed during this process.

Click "Mest' when you are ready to continue.

| Mext » | Cancel |

The user must have administrative privilege on the PC to proceed with the BIOS update. Otherwise, the
application will respond with a warning message and exit without updating the BIOS image. If the PC
has an administrative or setup password configured, HPQFlash will require the user to type the setup
password before the BIOS can be successfully updated.

HPQ Flash Wizard

Password Protection

The BIOS iz protected by a Setup password, You must enter the BIOS Setup pazsword
before the system BIOS can be updated.

Enter Pagsword: “

< Back | Mext » | Cancel

Q]
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If you click the Nlext button, type the correct password (if needed), and have the appropriate rights, the
application interrogates the current PC BIOS image and compares it to the BIOS image file (ROM.CAB)
in the same directory as the Flashbin.exe. If the BIOS image file is not applicable to the PC, a warning

message displays. If the image is applicable, HPQFlash displays the current BIOS and the BIOS version
contained in the ROM.CAB file.

HPQ Flash Wizard

Confirm Flash

b Y Yerify whether pou want to update your systemn BIOS.

“

Version of BIOS in ROM update: 78EAS +2.08
Version of BIOS in spsten: 78645 +1.09

Click 'Mest' to update wour syster BIOS.

§ < Back | Meut » | Cancel |

If the image file is applicable to the PC but is an older BIOS version that is currently installed, you receive
the following warning; however you can restore the older image to the PC if you click Next.

HPO\FIash Wizard

Confirm Flash

WARMIMG: The BIOS image contained in thizs ROM update iz not newer than the
! one that iz already present on your machine.

Wersion of BIOS in ROM update: 78E4A5 +1.09

Version of BIOS in system; TOBME 208

Click Mest' if you gtill veant to update your spstem BIOS.

< Back | Mest » | Cancel |

If you select Next, the BIOS flashing process begins, and you are warned not to interrupt the flashing
process. Interrupting the flashing process can corrupt the BIOS image. If the BIOS does not update suc-
cessfully, the PC enters flash recovery when rebooted.
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After the flash process successfully completes, the PC restarts automatically or immediately if you click
Restart before the timer expires. You can click Cancel to avoid the restart, but this is not recommended

since the updated BIOS image will not take effect until the PC reboots.

HPQ Flash Wizard

Completing the HPQ Flash Wizard

The zystem BIOS haz been updated successfully. The new
BIOS will be uzed the nest time the machine iz powered up.

It iz ghrongly recommended that you pover-down and restart
your aystem az sooh as possible.

The zystem must not hibermnate before being restarted,

The zystem will automatically restart when the counter

reaches zer.
[25

Restart | Cancel |

What are the steps necessary to execute the HPQPwsd utility?

The HPQPswd application is executed in the Windows environment by selecting the HPQPswd.exe file.

The initial HPQFlash application window is presented as follows to the user or administrator.

HPQPswd X

Thiz utility creates an encrypted file which contains
the pazsword used by HPGOFlazh to perform a silent
mode update aof the BIOS.

Pazzword to be |
encrypted

File to zave encrypted |

passward
Browse

About

Q]
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As indicated in the image, this utility creates an encrypted password file required to execute the HPQ-
Flash application in a silent mode on an administrative/setup password protected PC. HPQPswd utility is
an application which allows the user (typically a system administrator) to create an encrypted password
file which can be used with the /p option of the HPQFlash application. This option is usually used along
with the /s option to perform a silent mode update of a PC BIOS on Hewlett-Packard computers which
have a BIOS administrative/setup password set. The password file can be named and stored in any loca-
tion. However, it is best to store the file in the same subdirectory as the HPQFlash application. The HPQ-
Flash application silent mode will execute without user interaction.

Updating - General Questions

What steps are necessary to create the BIOS image CD for F10 ROM flash
and recovery?

The softpaq BIOS.iso allows the user or administrator to create binary image CD that can be used to
locally restore or update the system BIOS. This feature requires that a system is available with CD burning
software and a compatible CD-R/RW drive installed.

The following steps describe how the file can be used:

1. Obtain a blank CD and place it in the CD-R/RW drive.

2. Execute BIOS.iso to launch the CD burning software.

3. To make the BIOS binary image CD, follow instructions provided by the application.
4

Place the newly created BIOS binary image CD in the CD drive of the computer to be updated or
restored and cycle system power.

5. Follow the procedures detailed in the "“How do | update the BIOS when not running Windows XP,
Vista, or DOS?” on page 9" section.

What steps are necessary to create a bootable USB flash media (disk-on
key) for BIOS update?

A USB Flash Media Device can be made “bootable” to execute the Flashbin.exe utility. Please read the

following requirements and procedure completely before attempting to make the USB flash media device
bootable. If you are not comfortable with the steps, please do not attempt this procedure. Data loss can
result from improper execution.

Requirements:

®  System supporting USB flash media boot. Any Hewlett-Packard business PC with the following system
BIOS family:

1. 6860
2. 786A
3. 786B
4. 786C

Q]
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5. 786D

6. 786E

To verify this in your system:

1. Press F10 at boot time to enter Setup.

2. Select File > System Information to verify the correct system BIOS.
One of the USB flash media devices listed below:

1. HP Drive Key.

2. M-Systems USB DiskOnKey(R).

Microsoft Windows (Win 95 OSR2 or later) Startup diskette or DOS Bootable diskette with fdisk.exe
and sys.com files on the diskette.

To create a bootable flash media:

1.
2.

AN

10.

11.
12.

Turn off power to the computer.
Insert the USB flash media device into any of the computer USB ports.

NOTE: Unplug all USB storage devices (except USB Floppy drive) connected to the system other than
the USB flash media device that you plan to make bootable.

Insert Startup diskette or DOS Bootable diskette into the floppy drive.
Turn on power to the computer to boot from the Startup diskette.
Run Fdisk from the A:\ prompt by typing Fdisk and, then pressing Enter.

If prompted, select Yes to enable Large Disk support and answer Yes to any other questions that
appear on the screen.

Select option 5 to show multiple drives in the system. Write down the partition drive letter that has
been assigned to the USB flash media device. The drive letter is required to complete step 9. The drive
letter should also display the respective capacity (in Megabytes) of the USB flash media device.

IMPORTANT: Data loss can occur if the correct drive letfter is not noted.
Exit the Fdisk program by pressing the Esc key several times until you are back to the A:\ prompt.

At the A:\ prompt, type Sys X: where X: is the drive letter for the USB flash media device noted in
Step 7 above. Reconfirm that you have entered the correct drive letter for the USB flash media device.
If confirmed, press Enter. You will then see the message “System transfer successful” if successful.

IMPORTANT: Make sure you have typed the correct drive letter noted in Step 7 or data loss can
occur.

Remove the diskette and reboot the system. Do not remove the USB flash media device from the port
it was originally inserted.

The system will boot the USB flash media device as drive C:

Any of the supported systems can now be booted from this USB flash media device.
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After the USB flash media is made bootable, the Flashbin.exe, Assignpw.exe, and BIOS image file
(XXX_MMmm.bin) can be copied to the media. Boot the PC to be updated from the USB media and exe-
cute the Flashbin.exe as prescribed previously in the “How do | update the BIOS in a DOS environmeni?”
on page 8 section.

What steps are necessary to use SSM for BIOS update?

System administrators can use the BIOS update softPaq with System Software Manager (SSM) to update
the BIOS on target PCs on a network. Place this softPaq in your SSM Filestore folder then update the data-
base. SSM is a free utility provided by Hewlett-Packard Company. For information on SSM and this
remote BIOS update method, access the System Software Manager Web site at:
http://h18000.www1.hp.com/im/ssmwp.html.

What steps are necessary to use Altiris for BIOS update?

This section contains instructions for using Altiris Deployment server to deliver a BIOS update. This infor-
mation assumes that an Altiris Deployment server has been successfully configured. The basic steps
required for BIOS update through the Altiris Deployment server is as follows:

1. Copy Flashbin.exe, Adminpw.exe, and BIOS image to the server.

2. Create Flash.bat.

3. Create the Altiris ROM Flash Event.

4. Connect the Client PC to the Altiris Console.

Step 1: Copy Flashbin.exe, Adminpw.exe, and BIOS image to the server
1. Create a ROMFlash folder in the Altiris eXpress folder

2. Copy the following files to the ROMFlash folder:

a. Flashbin.exe
b. Assignpw.exe
c. XXX_MMmm.bin (desired BIOS update image)

Step 2: Create Flash.bat

1. Open a command box by clicking Start > Run, and typing cmd.
Type cd\express

Type cd ROMFlash

Type edit flash.bat

ook LN

Type in the following, where [Altiris Sever Name] is the name of the server:

a.net use k: \\[Altiris Sever Name]\express
b. k:

c. cd romflash
d. flashbin /l:us /f /flsh.cpu default

Save the file.
Exit Cmd.

Q]
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Step 3: Create ROM Flash Event in Altiris

No v s DN~

10.
11.
12.

13.

Select File > New > Event. This creates a new Event in the Events frame (bottom, left section)
Type in the name of the Event: ROM Flash

Double-click the new event to display an Event Properties form.

Click Add.

Select Run Script to display a new form

Select Run the script from file:

Click on the folder button. This is the button to the right of Run the script from file button and
has an image of a folder on it.

Select the file “flash.bat” created in the previous section.
Click Open.

Select DOS (from BootWorks).

Click OK.

The Events Properties Form should show:

Task: Run Script

Details: [path of the file]

Click OK.

Step 4: Connecting the Test Unit to the Altiris Console

1.
2.

Connect the client PC to the LAN with the Altiris Server.

On the client: Access the Altiris eXpress folder on the server:
a. Click Start > Run.

b. Type in the path to the server: \\[server name]\express
Run Aclient.exe.

a. Double-click Aclient.

b. Follow the instructions. When Aclient is properly installed and the system is connected to the Altiris
Console, the Altiris icon in the Windows Taskbar (next to the clock) will become blue.

On the server:
a. Right-click on the client computer name.
b. Select Properties.

c. Check Apply regular license.

The ROM Flash Event Setup is completed and will be delivered to the client PC.

Q]
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What if the PC does not complete the BIOS or ME flash process?

HP business PC products provide flash disaster recovery if the BIOS flash process fails to complete. The
BIOS will automatically detect that the BIOS flash process did not properly complete and boot in recovery
mode. With most business PC models, the user or administrator will be presented with the following
screen.

BootBlock Emergency Recovery Mode

The System Flash ROM [mage ls corrupted.

It will boot the PC in a recovery mode and search the root directory of the removable media sources
(USB, or CD) for a compatible binary image. The BIOS.iso file, included in the softpag, should be used to
create a BIOS image CD if the user or administrator desires to use CD media for BIOS recovery. When
flashing during recovery, the CD media, containing the BIOS image file, must be El-Torito compatible.
USB media source can simply contain the BIOS binary image file in the root directory. Once a binary
image is located, the BIOS update process will be attempted again. The automatic flash recovery will
continue until the BIOS is successfully updated or restored.

If no binary image is found, the PC will attempt to boot to diskette or USB flash media. The boot media
must have DOS for the disaster recovery mode to successfully boot.

The ME upgrade process in controlled by the Management Engine. If the upgrade process is not success-
fully completed or the attempted upgrade image is corrupted, the ME will abort the process and continue
with its current firmware image.

What is a processor microcode update softpag and how is it used?

Typical processors download code from the BIOS during initialization referred to as microcode. If a new,
supported processor is installed in the business PC which requires a microcode currently not adequately

provided by the BIOS, the BIOS will issue a POST warning “1801-Microcode Update Error”. To add this

microcode to the BIOS, a processor microcode softpaq is provided to update the BIOS. Processor micro-
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code changes can be updated in the BIOS without having to change the entire BIOS. Binary file micro-
code image is uUXX_MMmm.bin where the “u” indicates microcode, XX is the general BIOS family, MM is
major version, and mm is the minor version. Microcode updates can only be accomplished by using
Flashbin.exe utility.

Microcode update images are offered for the general BIOS family and can be applied to any particular
BIOS of that family. For example, microcode image u7D_0101.bin can be applied to any BIOS in the
786D family such as 786D1 or 786D2. Minor version numbers are incremented to indicate minimal
changes to the microcode typically involving an updated version of a previous released microcode. Major
version number changes indicate a greater degree of change to the microcode source such as the addi-
tion of a new processor microcode.

What does the BIOS binary image naming convention indicate?
Binary image format is XXX_MMmm.bin. The XXX portion indicates the BIOS family. The MM is the major

version number. The mm is the minor version number. The BIOS family is a collection of BIOS products all
originating from the same basic code source. For example, 7EX would indicate a BIOS image from the
786E BIOS family. Minor version numbers are incremented to indicate minimal changes to the BIOS
source code typically involving minor problem fixes. Major version number changes indicate a greater
degree of change to the BIOS source code such as new feature additions, additional hardware support,
or significant POST modifications.

Can | modify the BIOS POST splash screen?

The Image Flash (Flashi.exe) utility can be used to replace the POST splash image stored in the BIOS part
or save the current image. This DOS utility is typically provided for re-sellers who may want to be able to
put their own logo in place of the standard Hewlett-Packard image. Error checking is done to insure that
an image that does not meet the requirements above cannot be flashed into the ROM part. The utility
allows browsing through directories on the current disk. The images found can be viewed and a back-
ground color and a foreground color can be chosen from the colors in the image’s palette. The utility also
has a command line option to quickly flash a new image.

The image stored in the BIOS will be compressed with RLE4. If the image being flashed is already in
RLE4, the image flashed will be identical to the original except the second byte in the Bitmap Header will
be a checksum. If an uncompressed bitmap is flashed, the Image Flash Utility will encode it using RLE4
and save it. Therefore, when using the save (/s) feature to get the current image, the newly saved image
will be in RLE4 format, regardless of the format of the original image.

Usage to Flash Image:
Normal: Flashi.exe
Command Line Mode: Flashi.exe [Image_File] [Foreground_Color] [Background_Color]

The normal execution method will provide the user with additional interaction so that the image can be
selected from various files and a preview can be seen before the image is committed to the BIOS.

There is only a command line mode to save the current image. You cannot save the current image under
an existing file name.

Usage to Save Current Splash Image (command line only):

Command Line Mode: Flashi.exe /s name
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Summary

HP’s Business PC BIOS provides update methods to allow the user or administrator to manage the BIOS
and ME upgrades in a flexible manner. ME firmware images can be updated locally in a DOS or Win-
dows environment. HPQFlash offers a familiar, Windows application interface that allows the user to con-
fidently update the BIOS. Setup-based-flash and recovery provides a convenient, local upgrade method
which is not dependent on the PC operating system. The Flashbin utility provides a traditional DOS
upgrade operation for local or remote situations. Administrators can use the remote management capabil-

ities of such tools as SSM and Altiris to deliver enterprise wide upgrade ability.

Regardless of the BIOS or ME flash method, business PC products provide a high degree of upgrade reli-

ability and offer failure safe recovery.

For More Information

For the HP sales office nearest you, refer to your local phone directory, or call the HP regional office listed

below.

Corporate and North American headquarters

Hewlett-Packard

3000 Hanover Street

Palo Alto, CA 94304-1185
Phone: (650) 857-1501
Fax: (650) 857-5518

Regional headquarters

Latin America
Hewlett-Packard

Waterford Building, 9th Floor
5200 Blue Lagoon Drive
Miami, Florida 33126 USA
Phone: (305) 267-4220

Europe, Africa, Middle East

Hewlett-Packard
Route du Nant-d'Avril 150
CH-1217 Meyrin 2

Geneva, Switzerland
Phone: (41 22) 780-8111
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Asia Pacific

Hewlett-Packard Asia Pacific Ltd.
Hewlett-Packard Hong Kong Ltd.
9/F, Cityplaza One

111 King's Road

Taikoo Shing

Hong Kong

Phone: (852) 2599-7777

© 2006 Hewlett-Packard Development Company, L.P. The information in this document is subject to change without notice. The
only warranties for HP products and services are set forth in the express warranty statements accompanying such products and

services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or
editorial errors or omissions contained herein.

Microsoft, MS-DOS, Windows, and Windows NT are trademarks of Microsoft Corporation in the U.S. and other countries.

444316-001, 12/2006
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